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5.ACTIONS TRONG PHOTOSHOP 
TẠO 9 ẢNH 3X4 

 
 

BÀI 19 NGÀY 15.5.2011 ÚT BỈNH SOẠN 
 
TRONG CÁC PHIÊN BẢN CỦA PHOTOSHOP CS ĐỀU CÓ HIỆU ỨNG ACTIONS RẤT HAY . THÍ VỤ NHƢ 

SAU : BẠN CÓ MỘT ẢNH THẺ 3X4, MUỐN TẠO 9 ẢNH THẺ TRÊN MỘT KHỔ GIẤY LỚN NHƢ 10X15.2 
CM CHẲNG HẠN BẰNG CÁCH CHỈ NHẤP 2 PHÍM TẮT ĐỂ CHO RA 9 ẢNH .  ACTIONS CỦA 

PHOTOSHOP TỰ ĐỘNG CHẠY RẸT RẸT TRONG 2 GIÂY ĐỂ CUỐI CÙNG CHO RA KẾT QUẢ NHƢ BẠN 
MONG MUỐN MÀ KHÔNG CẦN LÀM MỘT THAO TÁC NÀO CẢ . NHANH VÀ HIỆU QUẢ CAO PHẢI 
KHÔNG BẠN ? BẠN CÓ CHỤP MỘT SỐ ẢNH KHOẢNG 20-30 ẢNH CHẲNG HẠN , NHỮNG ẢNH NẦY 

CÙNG CÓ LỖI THIẾU SÁNG DO TRỜI U ÁM , MÀU SẮC KHÔNG SẶC SỞ NHƢ Ý MUỐN , CÓ NHIỀU 
HẠT . BẠN MUỐN SỬA ĐỒNG LOẠT CÁC ẢNH NẦY BẰNG CÁCH NHẤP 2 PHÍM TẮT ĐỂ TRONG VÒNG 
VÀI GIÂY PHOTOSHOP TỰ ĐỘNG SỬA CHỮA HOÀN TẤT CÁC LỖI TRÊN , CHO RA NHỮNG ẢNH ĐẸP , 

ƢNG Ý MÀ KHÔNG MẤT NHIỀU THỜI GIỜ ? ACTIONS PHOTOSHOP SẼ GIÚP BẠN THỰC HIỆN ĐƢỢC 
ĐIỀU NẦY . 

ACTIONS PHOTOSHOP RẤT KHÓ TẠO SCRIPS ( KỊCH BẢN ) CHO TỪNG CÔNG DỤNG NÊU TRÊN  
(LẬP HÌNH THẺ VÀ HIỆU CHỈNH ẢNH XẤU) NẾU BẠN CỐ GẮNG ĐỌC CÁC SÁCH HƢỚNG DẪN . CÀNG 
ĐỌC CÀNG RỐI MÙ LÊN MÀ KHÔNG GIẢI QUYẾT ĐƢỢC GÌ CẢ . QUẢ LÀ BÀI HỌC KHÓ NUỐT, KHÓ 

THỰC HIỆN SUÔNG SẺ. KS DƢƠNG TRUNG HIẾU CÓ NHIỀU PHIM AVI TRONG DỈA ĐÃ PHỔ BIẾN 
GIÚP BẠN TẠO ACTIONS TRONG PHOTOSHOP RẤT DỄ DÀNG BẮT CHƢỚC. TUY NHIÊN HÌNH THỨC 

XUẤT BẢN DỈA CHỈ GIỚI HẠN KHI BẠN MUA ĐƢỢC DỈA . UTBINH CĂN CỨ VÀO CÁC PHIM NẦY VIẾT 
LẠI BẰNG TEXT ĐỂ PHỔ BIẾN RỘNG RÃI  TRÊN FORUMS GIÚP CÁC BẠN DỄ DÀNG TẠO ĐƢỢC TỪNG 
ACTION CHO TỪNG CÔNG DỤNG MONG MUỐN . THƢ CHO UTBINH KHI GẶP TRỞ NGẠI : 

utbinhdesign@gmail.com. CHÚC CÁC BẠN THỰC HIỆN ĐƢỢC VÀ VUI VỚI KẾT QUẢ MONG MUỐN . 
 

LINKS DOWNLOAD: 
 
 Download aƱ nh “goc3x4” đêƱ  thưƲ c tâƲ p: http://goo.gl/C5dLl 

 Download aƱ nh utbinh3x4 để thực tập: http://goo.gl/8nyxn 
 Tạo Dỉa Video Hướng dẫn thực hành Photoshop cảu KS Dương Trung Hiếu: 

http://goo.gl/vQbTu 
 Download File Actions “tao9anh3x4.atn” taƲ i (1,76 KB): http://goo.gl/ANugG 
 File aƱ nh 4x6 của bạn hoặc ảnh Brigitte Bardot tại: http://goo.gl/WcWWj 

 Tìm hiểu Máy In EPSON R230 TruyêƳn mưƲ c liên tuƲ c: http://goo.gl/EVfw  http://goo.gl/xoIi 
 

 

I.CHUÂƱ N BIƲ  AƱ NH 
 

1. Giảm dung lượng ảnh: Do UƧt BiƤ nh câƦn gơƤ i aƤ nh thƣƥ c tâƥ p đêƧn cho caƧc baƥ n nên câƦn phaƤ i neƧn 
ảnh giảm dung lƣợng dễ Up v à Download. NêƧu caƧc baƥ n coƧ săñ aƤ nh câƦn laƦm vơƧi dung lƣơƥ ng 
lơƧn cƣƧ lâƧy sƣƤ  duƥ ng  để ảnh có chất lƣợng cao , bỏ qua giai đoạn nén ảnh này  vì không câƦn 

thiêƧt. 

mailto:utbinhdesign@gmail.com
http://goo.gl/C5dLl
http://goo.gl/8nyxn
http://goo.gl/vQbTu
http://goo.gl/ANugG
http://goo.gl/WcWWj
http://goo.gl/EVfw
http://goo.gl/xoIi
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 Cách nén bằng Win 7 (Win XP cũng laƳm giôƴng vâƲ y): TrƣơƧc khi thƣƥ c tâƥ p, bạn cần 
chuâƤ n biƥ  môƥ t sôƧ aƤ nh. Do MaƧy Chuƥ p AƤ nh KTS hiêƥ n nay đêƦu cho caƧc aƤ nh vơƧi dung lƣơƥ ng 

râƧt lơƧn , bạn cần thu nhỏ lại chúng nếu muốn gởi ảnh lên Mạng để Ngƣời Xem 
download vêƦ thƣƥ c tâƥ p . Các bạn thực hiện việc thu nh ỏ dung lƣợng lại nhƣ sau : Bạn 

chƣƧa caƧc aƤ nh câƦn thu nhoƤ  trong môƥ t Folder đăƥ t taƥ i Desktop tên hinhthe > NhâƧp 
Ctrl+A đêƤ  choƥ n hêƧt > NhâƧp PhaƤ i > Chọn Send To > Chọn Mail Recipient. 

 

 
 
 

 
 

 
 
  

 
 

 
 
 

 
 

 
 
 

 
 
 

 Chọn kích cở Small (Có nhiều kích cơƤ  đêƤ  baƥ n choƥ n lƣƥ a) : 800 x 600 > NhâƧp Attach. 

 
 
 

  
 
 

 
 

 
 
 

 
 

 
 Bạn Copy các ảnh trong Khung Attached và dán vào Folder mơƧi taƥ o taƥ i Dektop tên 

hinhthe2. 
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II.CĂƴT AƱ NH 
 

2. MơƱ  chương tri Ƴnh Photoshop CS5 dạng gốc: Ở đây có 2 trƣờng hợp, mơƤ  chƣơng tri Ʀnh vơƧi 
ghi nhơƧ caƧc đôƥ ng taƧc trƣơƧc đoƧ baƥ n đa ̃thƣƥ c hiêƥ n thi Ʀ nhâƧp lên Shortcut mơƤ  bi Ʀnh thƣơƦng , còn 
nêƧu muôƧn mơƤ  daƥ ng măƥ c điƥ nh ban đâƦu thi Ʀ nhâƧp Shortcut đôƦng thơƦ i nhâƧp 3 phím một lƣợt là 

Shift+Ctrl+Alt > NhâƧp Yes. 
3. NhâƧp Menu File > NhâƧp Open > ĐêƧn Folder hinhthe Choƥ n aƤ nh “goc 3x4” (Ở đây Út Bỉnh lấy 

các File ảnh gốc có dung lƣợng lớn để thực tập mà không lấy ảnh trong Folder hinhthe 2 đa ̃
giảm dung lƣợng) > Ảnh đã hiện ra trong Vùng LaƦm Viêƥ c. 

4. Chọn công cụ Crop và nhập các tùy chọn theo hình. 

 
 

  
 
 

 
 

 
 
 

 
 
 

 
 

 
 

1. Rê lên aƤ nh taƥ o vuƦng choƥ n vaƦ nhâƧp Phi Ƨm muƤ i tên di chuyêƤ n vuƦng choƥ n đêƧn biƥ  tri Ƨ thi Ƨch hơƥ p > 

Xong, nhâƧp Phi Ƨm Enter  > NhâƧp Menu Image > NhâƧp Image Size, hiêƥ n ra aƤ nh đa ̃căƧt vơƧi ki Ƨch 
cơƤ  đa ̃choƥ n.  

 
 
 

 
 
  

 
 

 
 
 

 
 

 
 
 

 
 

 

2. Lưu ki ƴch cơƱ  đã choƲ n trong Crop đêƱ  lâƳn sau sưƱ  duƲ ng laƲ i : NhâƧp xôƤ  xuôƧng > NhâƧp NuƧt 
vuông nhoƤ  > Xóa bớt chỉ còn 3 cm x 4 cm > NhâƧp Ok. LâƦn sau chiƤ  câƦn nhâƧp xôƤ  xuôƧng choƥ n 

kích cở này mà không cần gỏ nhập lại. 
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3. Lưu aƱ nh: NhâƧp Ctrl+Shift+S > Hàng Save đã có tên Folder hinhthe cuƤ a aƤ nh thƣƥ c tâƥ p , File 
Name đăƥ t tên goc3x4 > NhâƧp NuƧt Save > NhâƧp Ok. 

 

 
 
 

  
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 
 

 
 

 
 

III.CHỈNH SỬA ẢNH 
 
Ảnh này hơi thiếu sáng có độ đậm nên chỉ cần chỉnh cho sáng ra là đủ . Vì mục đích của bài này 

hƣơƧng dâñ taƥ o Actions nên không đi sâu vaƦo chi tiêƧt chiƤ nh sƣƤ a aƤ nh. 
 

1. NhâƧp Ctrl+M đêƤ  mơƤ  Curves > Chỉnh theo hình > NhâƧp Ok. 

2. Save: Ctrl+Shift+S > NhâƧp NuƧt Save > Ok > Ok. Bạn đã lƣu ảnh này đè lên ảnh trƣớc đó. 
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IV.TẠO ACTIONS 
 
Bạn cần tạo Actions để chỉ cần lấy Actions này Load về máy Tính khác , nhâƧp 2 Phím Tắt , chƣơng 

trình Photoshop se ̃tƣƥ  đôƥ ng  taƥ o 9 ảnh 3x4 cm trên KhôƤ  giâƧy 10 x15.2 cm. 
 

1. MơƱ  Tab Layers: NhâƧp Phi Ƨm F7 để mở Tab Layers. 
2. MơƱ  Tab Actions: NhâƧp Menu Windows > NhâƧp Actions (Alt+F9) để mở Tab Actions. 
3. Tạo New Set : NhâƧp NuƧt New Set đaƧy Tab Actions > Name nhâƥ p: Tao9anh3x4 > NhâƧp Ok. 

Đây laƦ tên cuƤ a môƥ t Action maƦ baƥ n săƧp taƥ o ra , bạn  tạo xong Save lại và gởi đến Ngƣời Xem 
download vêƦ thƣƥ c hiêƥ n nhâƧp 2 phím tắt tự động tạo 9 ảnh 3x4 trên khôƤ  giâƧy 10 x15.2 cm. 

 
 
 

  
 
 

 
 

 
 
 

 
 

 
 
 

 
 
 

 
 

 
 

 Trong Tab Actions đa ̃coƧ Tiêu đêƦ Tao9anh3x4. 
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4. Tạo New Actions: NhâƧp NuƧt New Actions ơƤ  đaƧy Tab Actions > Neme nhâƥ p: 15052011(Ngày 

tạo actions này) > Function Key choƥ n F 2 và Shift (Đây laƦ 2 Phím tắt bạn chỉ cần nhấp lên nó 
sẽ tự động thực thi tạo 9 ảnh cho bạn) > NhâƧp NuƧt Record. 

 
 
 

 
 
 

   
 

 
 
 

 
 

 
 
 

 
 

 Băƴt đâƳu Thu Actions: Bạn thấy trong Tab Actions đã có ngày tạo Actions và Phím Tắt 
qui điƥ nh. DƣơƧi Tab coƧ nuƧt Record baƧo cho baƥ n biêƧt kêƦ tƣƦ  giơƦ phuƧt naƦy moƥ i đôƥ ng taƧc 

của bạn đều đƣợc ghi lại để sau này tạo thành 1 file goƥ i laƦ Actions do đoƧ baƥ n nên câƤ n 
thâƥ n khi thao taƧc traƧnh nhiêƦu lâƦm lôĩ . Nút Stop bên Trái là ngƣng thu và nút Play bên 
Phải là Phát ra những động tác liệt kê trong Tab Actions mà bạn đã thực hiện. 
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5. Tạo Action con thứ 1: Nhấp đúp lên Layer Background > NhâƧp Ok > Đa ̃đôƤ i Layer 
Background thaƦnh Layer 0 mục đích sau này bạn sẽ có nền Transparent , nêƧu không laƦm nhƣ 

vâƥ y baƥ n se ̃coƧ nêƦn maƦu đen trông khoƧ chiƥ u > Bạn thấy trong Tab Actions đã có Action con t ên 
Set Background. 

 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 
 

 
 

 
 
 

 
 

6. Tạo Action con thứ 2: NhâƧp Menu Image > Chọn Canvas Size > Chọn cm - Width nhâƥ p 10 
– Height nhâƥ p 15.2 – ĐaƧnh dâƧu Relative – Mục Anchor nhấp góc Trái trên để chỉ định ảnh sẽ 
hiêƥ n ơƤ  đây trên KhôƤ  giâƧy in aƤ nh ki Ƨch thƣơƧc 10x15.2 cm > NhâƧp OK > Đa ̃hiêƥ n ra aƤ nh thƣƧ 1 

năƦm goƧc TraƧi trên nêƦn Transparent nhƣng quaƧ lơƧn nên baƥ n phaƤ i nhâƧp Ctrl vaƦ dâƧu – nhiêƦu lâƦn 
để thu nhỏ ảnh lại. 
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7. Tạo Action con thứ 3: Tạo ảnh thứ 2: NhâƧp Ctrl+J đêƤ  nhân baƤ n > Ctrl+T đêƤ  coƧ 8 nút dể di 
chuyêƤ n > Giƣ̃ Phi Ƨm Shift vaƦ di chuyêƤ n aƤ nh qua PhaƤ i > NhâƧp Enter. 

8. Tạo Action con thứ 4: Tạo ảnh thứ 3: NhâƧp Ctrl+J đêƤ  nhân baƤ n > Ctrl+T đêƤ  coƧ 8 nút dể di 
chuyêƤ n > Giữ Phím Shift và di chuyển ảnh qua Phải > NhâƧp Enter. 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 
 

 
1. Tạo Action con thứ 5: Gom nhoƧm 3 ảnh lại: Ctrl+Shift+E > Đa ̃thaƦnh 1 Layer. 

2. Tạo Action con thứ 6: Tạo Hàng thứ 2 có 3 ảnh: Ctrl+J > Ctrl+T > Giƣ̃ Shift vaƦ rê 
xuôƧng dƣơƧi > Phím Enter. 

3. Tạo Action con thứ 7: Tạo Hàng thứ 3 có 3 ảnh: Ctrl+J > Ctrl+T > Giƣ̃ Shift vaƦ rê 

xuôƧng dƣơƧi > Phím Enter. 
4. Tạo Action con thứ 8: Gom nhoƧm 3 hàng ảnh: Ctrl+Shift+E 

5. Tạo Action con thứ 9: Canh chiƤ nh 9 ảnh: Ctrl+T > Giƣ̃ Shift vaƦ rê vaƦo tâm KhôƤ  giâƧy in > 
Enter. 

6. NhâƧp NuƧt Stop ngƣng thu Actions. 

 
 

 
 
 

  
 
 

 
 

 
 
 

 
 

 
 
 

 
 
 

 
 

 



9 

 

7. Lưu laƲ i AƱ nh vưƳ a taƲ o: NhâƧp Shift+Ctrl+S > Ra cƣƤ a sôƤ  Save As, chọn Folder hinhthe > 
File name nhâƥ p 9anh3x4 > NhâƧp NuƧt Save > NhâƧp Ok. 

 
 
 

 
 
 

  
 

 
 
 

 
 

 
 
 

 
 
 

 
 

 
 
 

 
 

8. Lưu Actions: NhâƧp tên New Set >  NhâƧp nuƧt xôƤ  xuôƧng goƧc PhaƤ i Tab Actions > Hiêƥ n ra 
Menu con, chọn Save Actions. 

 

 
 

 
 
  

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 

 Hiêƥ n ra CƣƤ a sôƤ  Save , chọn Folder hinhthe > File name đêƤ  măƥ c điƥ nh – Điƥ nh daƥ ng l à 

.*ATN > NhâƧp nuƧt Save. 
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9. Áp dụng cho ảnh khác : Bạn đóng ảnh thực tập lại > MơƤ  môƥ t aƤ nh 3x4 khác > NhâƧp 

Phím tắt Shift+F2 > Sau 2 giây chaƥ y reƥ t reƥ t baƥ n đa ̃coƧ 9 ảnh 3x4 trên khôƤ  giâƧy 10x15.2 cm 

> NhâƧp Ct rl+Shift+S vaƦ lƣu trong Folder hinhthe – File name nhâƥ p 9anhutbinh – điƥ nh 
dạng JPEG  
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V.SƯƱ  DUƲ NG FILE ACTIONS. 
 

1. Download File tao 9anh3x4 điƥ nh daƥ ng .atn taƥ i (1,76 KB): http://goo.gl/ANugG > Lƣu taƥ i 
Folder hinhthe taƥ i Desktop. 

2. MơƤ  Photoshop CS 5 > MơƤ  File aƤ nh 4x6 của bạn hoặc ảnh Brigitte Bardot tại : 

http://goo.gl/WcWWj > Bạn cắt ảnh thành 3x4 cm > NhâƧp Alt+F9 để mở Tab Actions > 
NhâƧp xôƤ  xuôƧng cuƤ a Tab Actions, chọn Load Actions. 

 
 
 

 
  

 
 
 

 
 

 
 
 

 
 
 

 
 

 
 
 

 
 

 
 

1. Hiêƥ n ra cƣƤ a sôƤ  Load, đến nơi lƣu File Actions > NhâƧp Load. 

 
 
 

 
  

 
 
 

 
 

 
 
 

 
 
 

 
 

 
 
 

 

http://goo.gl/ANugG
http://goo.gl/WcWWj
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2. Bạn đã có New Set Tao9anh3x4 trong Tab Actions,  
 

 
 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
3. NhâƧp lên New Actions 15052011 > NhâƧp NuƧt Play đaƧy Tab Actions > Lâƥ p tƣƧc baƥ n đa ̃coƧ 9 anh 

3x4 trong KhôƤ  giâƧy in 10x15.2 cm > Bạn chú ý: 2 Phím tắt hiện kêƧ bên 15052011 là Shift+F2. 

4. Hoăƥ c NhâƧp Phi Ƨm Shift+F2 lâƥ p tƣƧc hiêƥ n ra 9 anh 3x4 trong KhôƤ  giâƧy in 10x15.2 cm > Bạn Save 
lại với định dạng JPG rồi chép vào USB đem ra tiệm in ảnh. 
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VI.CÁCH SỬ DỤNG TAB ACTIONS 
 

 
Trong Tab Actions, bạn có thể: 
 

 ĐêƱ  hiêƲ n ra  Tab Actions: NhâƧp Menu Windows vaƦ nhâƧp Actions (Alt+F9). 

 
 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 
 

 
 

 
 
 

 
 

 
 
 

 
 

 
 New Set:  ĐêƤ  đăƥ t tên Tiêu ĐêƦ cho Actions (Tao9anh3x4). NhâƧp NuƧt đaƧy Tab Actions 

 New Actions: ĐêƤ  đăƥ t tên ngaƦy taƥ o vaƦ phi Ƨm tăƧt thƣƥ c hiêƥ n actions (15052011). NhâƧp NuƧt đaƧy 
Tab Acrtions. 

 Hủy bỏ Cả New Set: Chọn New Set và rê xuống thùng rác đáy Tab Actions. 
 Hủy bỏ từng Actions con: Chọn và rê xuống thùng rác. 

 Save Actions: MuôƧn Save New Set naƦo thi Ʀ nhâƧp lên New Set đoƧ > NhâƧp xôƤ  xuôƧng bên PhaƤ i 

Tab Actions > NhâƧp Save Actions. 
 Load Actions: MuôƧn Load Actions vaƦo MaƧy Ti Ƨnh cuƤ a baƥ n : MơƤ  Tab Actions > NhâƧp xôƤ  xuôƧng 

bên PhaƤ i Tab Actions > NhâƧp Load Actions. 
 Thêm Actions con giữa chưƳ ng : Chọn 1 actio ơƤ  giƣ̃a > Thao taƧc trên maƦn hi Ʀnh > Đa ̃coƧ 

chèn thêm 1 action con ơƤ  dƣới đó. 
 Di chuyêƱ n Actions: Bạn có thể rê di chuyển 1 action vaƦo bâƧt cƣƧ viƥ  tri Ƨ naƦo. 

 Bạn có thể thay đổi Phím Tắt : NhâƧp đuƧp bên PhaƤ i New Actions 15052011 > Hiêƥ n ra Actions 
Options, Nhâƥ p tên – Chọn Phím tắt – Chọn Shift – Chọn Color > NhâƧp Ok.  
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Download các Files Actions về sử dụng :  
Máy Canon 960 chụp Hình Phong Cảnh ( Phím tắt F2 ) : http://tinyurl.com/5s7kwz 

Hình Thẻ ( Phím Shift+F2 ) : http://tinyurl.com/6dcown 
HÌnh Phong Cảnh ( Phím Shift+F3 ) : http://tinyurl.com/5l6n2l 

Hình Phong Cảnh ( Phím Shift+F4) : http://tinyurl.com/5b794a 
Để tham khảo thêm nhiều tài liệu chuyên đề Actions , bạn nên vào : 
http://www.youtube.com > Nhập : Actions Photoshop cs3 > Hiện ra nhiều Files 

Videos hướng dẫn tạo Actions rất hay . 

 

http://tinyurl.com/5s7kwz
http://tinyurl.com/6dcown
http://tinyurl.com/5l6n2l
http://tinyurl.com/5b794a
http://www.youtube.com/

